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Introduction

I’m very proud to present you with the completely revamped and almost
totally brand new Excel 2007 For Dummies, the latest version of everybody’s

favorite book on Microsoft Office Excel for readers with no intention whatso-
ever of becoming spreadsheet gurus. The dramatic changes evident in this
version of the book reflect the striking, dare I say, revolutionary changes that
Microsoft has brought to its ever-popular spreadsheet program. One look at
the new Ribbon command structure and all those rich style galleries in Excel
2007 and you know you’re not in Kansas anymore ‘cause this is definitely not
your mother’s Excel!

In keeping with Excel’s more graphical and colorful look and feel, Excel 2007
For Dummies has taken on some color of its own (just take a gander at those
color plates in the mid-section of the book) and now starts off with a defini-
tive introduction to the new user Ribbon interface. This chapter is written
both for those of you for whom Excel is a completely new experience and
those of you who have had some experience with the old pull-down menu
and multi-toolbar Excel interface who are now faced with the seemingly
daunting task of getting comfortable with a whole new user experience.

Excel 2007 For Dummies covers all the fundamental techniques you need
to know in order to create, edit, format, and print your own worksheets.
In addition to showing you around the worksheet, this book also exposes
you to the basics of charting, creating data lists, and performing data analysis.
Keep in mind, though, that this book just touches on the easiest ways to
get a few things done with these features — I make no attempt to cover
charting, data lists, or data analysis in the same definitive way as spread-
sheets: This book concentrates on spreadsheets because spreadsheets are
what most regular folks create with Excel.

About This Book
This book isn’t meant to be read cover to cover. Although its chapters are
loosely organized in a logical order (progressing as you might when studying
Excel in a classroom situation), each topic covered in a chapter is really meant
to stand on its own.
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Each discussion of a topic briefly addresses the question of what a particular
feature is good for before launching into how to use it. In Excel, as with most
other sophisticated programs, you usually have more than one way to do a
task. For the sake of your sanity, I have purposely limited the choices by usu-
ally giving you only the most efficient ways to do a particular task. Later on,
if you’re so tempted, you can experiment with alternative ways of doing a
task. For now, just concentrate on performing the task as I describe.

As much as possible, I’ve tried to make it unnecessary for you to remember
anything covered in another section of the book. From time to time, however,
you will come across a cross-reference to another section or chapter in the
book. For the most part, such cross-references are meant to help you get more
complete information on a subject, should you have the time and interest. If
you have neither, no problem; just ignore the cross-references as if they never
existed.

How to Use This Book
This book is like a reference in which you start out by looking up the topic
you need information about (in either the table of contents or the index), and
then you refer directly to the section of interest. I explain most topics conver-
sationally (as though you were sitting in the back of a classroom where you
can safely nap). Sometimes, however, my regiment-commander mentality
takes over, and I list the steps you need to take to accomplish a particular
task in a particular section.

What You Can Safely Ignore
When you come across a section that contains the steps you take to get
something done, you can safely ignore all text accompanying the steps
(the text that isn’t in bold) if you have neither the time nor the inclination to
wade through more material.

Whenever possible, I have also tried to separate background or footnote-type
information from the essential facts by exiling this kind of junk to a sidebar
(look for blocks of text on a gray background). These sections are often flagged
with icons that let you know what type of information you will encounter there.
You can easily disregard text marked this way. (I’ll scoop you on the icons I use
in this book a little later.)

2 Microsoft Office Excel 2007 For Dummies 
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Foolish Assumptions
I’m going to make only one assumption about you (let’s see how close I get):
You have access to a PC (at least some of the time) that is running either
Windows Vista or Windows XP and on which Microsoft Office Excel 2007 is
installed. However, having said that, I make no assumption that you’ve ever
launched Excel 2007, let alone done anything with it.

This book is intended ONLY for users of Microsoft Office Excel 2007! If you’re
using any previous version of Excel for Windows (from Excel 97 through 2003),
the information in this book will only confuse and confound you as your ver-
sion of Excel works nothing like the 2007 version this book describes.

If you are working on an earlier version of Excel, please put this book down
slowly and instead pick up a copy of Excel 2003 For Dummies, published by
Wiley Publishing.

How This Book Is Organized
This book is organized in six parts (which gives you a chance to see at least
six of those great Rich Tennant cartoons!). Each part contains two or more
chapters (to keep the editors happy) that more or less go together (to keep
you happy). Each chapter is further divided into loosely related sections that
cover the basics of the topic at hand. You should not, however, get too hung
up on following along with the structure of the book; ultimately, it doesn’t
matter at all if you find out how to edit the worksheet before you learn how
to format it, or if you figure out printing before you learn editing. The impor-
tant thing is that you find the information — and understand it when you find
it — when you need to perform a particular task.

In case you’re interested, a synopsis of what you find in each part follows.

Part I: Getting In on the Ground Floor
As the name implies, in this part I cover such fundamentals as how to start the
program, identify the parts of the screen, enter information in the worksheet,
save a document, and so on. If you’re starting with absolutely no background
in using spreadsheets, you definitely want to glance at the information in
Chapter 1 to discover the secrets of the new Ribbon interface before you
move on to how to create new worksheets in Chapter 2.

3Introduction
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Part II: Editing Without Tears
In this part, I show how to edit spreadsheets to make them look good, as well
as how to make major editing changes to them without courting disaster.
Peruse Chapter 3 when you need information on formatting the data to
improve the way it appears in the worksheet. See Chapter 4 for rearranging,
deleting, or inserting new information in the worksheet. And read Chapter 5
for the skinny on printing out your finished product.

Part III: Getting Organized
and Staying That Way
Here I give you all kinds of information on how to stay on top of the data that
you’ve entered into your spreadsheets. Chapter 6 is full of good ideas on how
to keep track of and organize the data in a single worksheet. Chapter 7 gives
you the ins and outs of working with data in different worksheets in the same
workbook and gives you information on transferring data between the sheets
of different workbooks.

Part IV: Digging Data Analysis
This part consists of two chapters. Chapter 8 gives you an introduction to
performing various types of what-if analysis in Excel, including setting up
data tables with one and two inputs, performing goal seeking, and creating
different cases with Scenario Manager. Chapter 9 introduces you to Excel’s
vastly improved pivot table and pivot chart capabilities that enable you to
summarize and filter vast amounts of data in a worksheet table or data list
in a compact tabular or chart format.

Part V: Life Beyond the Spreadsheet
In Part V, I explore some of the other aspects of Excel besides the spreadsheet.
In Chapter 10, you find out just how ridiculously easy it is to create a chart
using the data in a worksheet. In Chapter 11, you discover just how useful
Excel’s data list capabilities can be when you have to track and organize a
large amount of information. In Chapter 12, you find out about using add-in
programs to enhance Excel’s basic features, adding hyperlinks to jump to new
places in a worksheet, to new documents, and even to Web pages, as well as
how to record macros to automate your work.
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Part VI: The Part of Tens
As is the tradition in For Dummies books, the last part contains lists of the
top ten most useful and useless facts, tips, and suggestions. In this part,
you find three chapters. Chapter 13 provides my top ten list of the best
new features in Excel 2007 (and boy was it hard keeping it down to just ten).
Chapter 14 gives you the top ten beginner basics you need to know as you
start using this program. And Chapter 15 gives you the King James Version
of the Ten Commandments of Excel 2007. With this chapter under your belt,
how canst thou goest astray?

Conventions Used in This Book
The following information gives you the lowdown on how things look in this
book — publishers call these items the book’s conventions (no campaigning,
flag-waving, name-calling, or finger-pointing is involved, however).

Keyboard and mouse
Excel 2007 is a sophisticated program with a whole new and wonderful
user interface, dubbed the Ribbon. In Chapter 1, I explain all about this new
Ribbon interface and how to get comfortable with its new command structure.
Throughout the book, you’ll find Ribbon command sequences using the short-
hand developed by Microsoft whereby the name on the tab on the Ribbon and
the command button you select are separated by vertical bars as in:

Home | Copy

This is shorthand for the Ribbon command that copies whatever cells or
graphics are currently selected to the Windows Clipboard. It means that you
click the Home tab on the Ribbon (if it’s not already displayed) and then click
the Copy button (that sports the traditional side-by-side page icon).

Some of the Ribbon command sequences involve not only selecting a com-
mand button on a tab but then also selecting an item on a drop-down menu.
In this case, the drop-down menu command follows the name of the tab and
command button, all separated by vertical bars, as in:

Formulas | Calculation Options | Manual
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This is shorthand for the Ribbon command sequence that turns on manual
recalculation in Excel. It says that you click the Formulas tab (if it’s not already
displayed) and then click the Calculation Options button followed by the
Manual drop-down menu option.

Although you use the mouse and keyboard shortcut keys to move your way
in, out, and around the Excel worksheet, you do have to take some time to
enter the data so that you can eventually mouse around with it. Therefore,
this book occasionally encourages you to type something specific into a spe-
cific cell in the worksheet. Of course, you can always choose not to follow the
instructions. When I tell you to enter a specific function, the part you should
type generally appears in bold type. For example, =SUM(A2:B2) means that
you should type exactly what you see: an equal sign, the word SUM, a left
parenthesis, the text A2:B2 (complete with a colon between the letter-number
combos), and a right parenthesis. You then, of course, have to press Enter to
make the entry stick.

When Excel isn’t talking to you by popping up message boxes, it displays
highly informative messages in the status bar at the bottom of the screen.
This book renders messages that you see on-screen like this:

Calculate

This is the message that tells you that Excel is in manual recalculation mode
(after using the earlier Ribbon command sequence) and that one or more of
the formulas in your worksheet are not up-to-date and are in sore need of
recalculation.

Occasionally I give you a hot key combination that you can press in order to
choose a command from the keyboard rather than clicking buttons on the
Ribbon with the mouse. Hot key combinations are written like this: Alt+FS or
Ctrl+S (both of these hot key combos save workbook changes). 

With the Alt key combos, you press the Alt key until the hot key letters
appear in little squares all along the Ribbon. At that point, you can release
the Alt key and start typing the hot key letters (by the way, you type all 
lowercase hot key letters — I only put them in caps to make them stand
out in the text).

Hot key combos that use the Ctrl key are of an older vintage and work a little
bit differently. You have to hold down the Ctrl key as you type the hot letter
(though again, type only lowercase letters unless you see the Shift key in the
sequence, as in Ctrl+Shift+C).
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Excel 2007 uses only one pull-down menu (the File pull-down menu) and one
toolbar (the Quick Access toolbar). You open the File pull-down menu by
clicking the Office Button (the four-color round button in the upper-left
corner of Excel program window) or pressing Alt+F. The Quick Access toolbar
with its four buttons appears to the immediate right of the Office Button.

All earlier versions of this book use command arrows to lead you from the
initial pull-down menu, to the submenu, and so on, to the command you
ultimately want. For example, if you need to open the File pull-down menu
to get to the Open command, that instruction would look like this: Choose
File➪Open. This is the equivalent of Office Button | Open and Alt+FO.
Commands using the older command arrow notation rather than the vertical
bar notation occur only in the tables in Chapter 1 for people upgrading to
Excel 2007 from older versions of Excel.

Finally, if you’re really observant, you may notice a discrepancy between the
capitalization of the names of dialog box options (such as headings, option
buttons, and check boxes) as they appear in text and how they actually
appear in Excel on your computer screen. I intentionally use the convention
of capitalizing the initial letters of all the main words of a dialog box option to
help you differentiate the name of the option from the rest of the text describ-
ing its use.

Special icons
The following icons are strategically placed in the margins to point out stuff
you may or may not want to read.

This icon alerts you to nerdy discussions that you may well want to skip
(or read when no one else is around).

This icon alerts you to shortcuts or other valuable hints related to the topic
at hand.

This icon alerts you to information to keep in mind if you want to meet with a
modicum of success.

This icon alerts you to information to keep in mind if you want to avert com-
plete disaster.
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Where to Go from Here
If you’ve never worked with a computer spreadsheet, I suggest that, right
after getting your chuckles with the cartoons, you first go to Chapter 1 and
find out what you’re dealing with. And, if you’re someone with some experi-
ence with earlier versions of Excel, I want you to head directly to the section,
“Migrating to Excel 2007 from Earlier Versions” in Chapter 1, where you find
out how to stay calm as you become familiar and, yes, comfortable with the
new Ribbon user interface. 

Then, as specific needs arise (such as, “How do I copy a formula?” or
“How do I print just a particular section of my worksheet?”), you can go
to the table of contents or the index to find the appropriate section and
go right to that section for answers.
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Part I
Getting In on the

Ground Floor
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In this part . . .

One look at the Excel 2007 screen with its new
Microsoft Office Button, Quick Access toolbar, and

Ribbon, and you realize how much stuff is going on here.
Well, not to worry: In Chapter 1, I break down the parts
of the Excel 2007 Ribbon user interface and make some
sense out of the rash of tabs and command buttons that
you’re going to be facing day after day after day.

Of course, it’s not enough to just sit back and have some-
one like me explain what’s what on the screen. To get any
good out of Excel, you’ve got to start learning how to use
all these bells and whistles (or buttons and boxes, in this
case). That’s where Chapter 2 comes in, giving you the
lowdown on how to use some of the screen’s more promi-
nent buttons and boxes to get your spreadsheet data
entered. From this humble beginning, it’s a quick trip to
total screen mastery.
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